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What a PowerPoint is or isn’t
PowerPoint presentations are one of the most 
common ways to share information. But they are 
also one of the most misused. When considering 
accessibility we have to be intentional about our 
decisions and understand how they impact the 
user experience. The Accessibility for PowerPoint 
checklist in this handout will give you some 
great things to think about as you develop your 
slide decks. Here are the three most common 
presentation challenges:
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Cognitive Overload
Are you adding too much stuff? Crowding your slides with lots of text or pictures makes it 
hard for people to understand the main points when there’s too much going on. It’s better 
to keep things simple and clear by using short bullet points or helpful visuals. If you want to 
create a handout that has supporting info, do it. Just don’t cram it all into your live slide deck. 
Or, consider adding more slides. One of the benefits of digital content is that page count is 
really less important. How well you deliver your presentation clearly is paramount.

‘See and Say’ Presentations
This type of presentation is a bit tricky when it comes to accessibility. In fact, we DO want to 
read what is on the screen. However, that does not mean we just stare at our presentation 
and read all the text with no other context just because it needs to be accessible. This ties 
back to Cognitive Overload. Keep your bullets short and support them with spoken words. 
Another consideration here is people who lip read. Turning toward your slides all the time 
to read long paragraphs or bullets creates a challenge for people who rely on lip reading for 
comprehension. It’s important for you to balance what you’re saying with direct engage with 
the audience by speaking directly to them.

Interpreting complex information
Some presenters use too many fancy fonts, animations, sounds, or transitions that don’t 
really add to the information. These things can be fun, but if they’re used too much, they 
can be distracting or annoying. Also, relying only on PowerPoint can limit creativity and 
flexibility in how information is shared. It’s good to try different ways like telling stories, 
doing demonstrations, or getting the audience involved. By using PowerPoint wisely and 
finding other ways to connect with the audience, presentations can be more interesting and 
effective. Just remember to include a Sign Language Interpreter, transcript or captions if you 
are delivering mostly spoken content.

The 10 Accessibility 
Features of PowerPoint

1. Heading structure is linked to 
Template Styles (H1 and H2)

2. Reading Order: Set reading order 
via Selection Pane or Read Order 
Pane

3. Alternate Descriptions: The ability 
to describe Image-based content

4. Screen Tips: Descriptive text for 
Hyperlinks

5. Automatic Subtitles: In English or 
live translation to other languages 
(not super accurate)

6. Video Captions: Using STAMP 
Plugin for PowerPoint

7. Export settings for accessibility 
tags and reflow

8. Convert speakers notes: The ability 
to convert speakers notes to 
comments on export to PDF

9. Export Bookmarks: Creates 
Bookmarks on export based on 
Headings
Microsoft Accessibility Checker: 
Checks for a wide variety of 
accessibility barriers. (This is a start 
but do not assume passing is the 
same as an accessible document
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10 Tips for giving an accessible presentation
When we say “accessible presentation” we are really talking about several consideration. They typically benefit people who are deaf, people 
who are blind, or people who are neurodiverse. Neurodiversity includes Autism, ADHD, Dyslexia, and other sensory processing difference. 

Here are 10 tips to help you deliver an 
accessible presentation:

1. Speak Clearly and Slowly: Enunciate your 
words clearly and avoid rushing through 
your presentation. This helps individuals 
with hearing impairments, non-native 
English speakers, and those who rely on lip 
reading.

2. Provide captioning: Include captions 
or subtitles for all spoken content in 
your presentation, making it accessible 
to deaf attendees. Use tools or services 
that generate accurate captions. Accruate 
captions are really important for a good user 
experience.

3. When possible, utilize sign language 
interpretation: Arrange for a qualified sign 
language interpreter to be present during 
your presentation, enabling deaf attendees 
to understand the spoken content through 
sign language.

4. Use high contrast visuals: Ensure that 
your slides and visual materials have a high 
contrast between text and background, 
making them easier to read for individuals 
with visual impairments.

5. Provide alt text for images: Add 
alternative text (alt text) to describe images 
used in your presentation. This allows blind 
attendees to understand the visual content 
through screen readers.

6. Avoid complex visual effects: Minimize 
the use of animations, flashy transitions, 
or rapidly changing visuals, as they can be 
distracting or confusing for attendees with 
visual impairments.

7. Use accessible templates and features 
within PowerPoint: You can easy 
integration captions, alt text, and other 
accessibility elements in PowerPoint.

8. Offer handouts or accessible digital 
materials: Provide printed handouts 
or accessible digital copies of your 
presentation materials in advance, allowing 
attendees to follow along or review the 
content after the presentation.

9. Speak clearly and use descriptive 
language: Enunciate your words clearly, 
and use descriptive language to explain 
visuals or key points. This helps individuals 
who are blind or have hearing impairments 
to follow your presentation.

10. Allow for questions and clarifications: 
Encourage attendees to ask questions 
or seek clarifications throughout your 
presentation, ensuring that everyone has an 
opportunity to understand the content fully.

4 of 31

Ultimate Guide to Accessible PowerPoints
Dax Castro, ADS

Accessing Higher Ground 2023



Where you start makes a 
difference
It is important to incorporate accessibility 
considerations at the earliest stage possible. 
The stage at which we consider accessibility 
directly impacts how long it will take 
to make the product accessible, what 
approach we use to do so, and ultimately 
how usable and informative the content is. If 
we start late, our goal of a single, equitable, 
accessible experience for everyone often 
fails because “there’s not enough time” or 
“this has already been approved and we 
can’t change it.” 

When teams start designing with 
accessibility in mind from the beginning, 
there are more options to present a single, 
meaningful user experience. Depending 
on what stage you begin incorporating 
accessibility, you can increase or limit your 
ability to employ accessible design by 
affecting your timeline or your attachment 
to current designs. 

Starting at the Concept Stage 
When you want to make an accessible 
PowerPoint, it’s important to plan ahead and 
consider how users will interact with it. Start by 
asking yourself a crucial question: 

“What do I want the 
user experience to be?

This question affects everything from your 
PowerPoint template to the slides and 
overall design. If you don’t think about this 
early you might end up with accessibility 
problems that you didn’t realize were 
there. Also, keep in mind that listening to 
descriptions of images is an interactive 
experience. What we say about an image 
and how we say it adds to the overall 
presentation. By thinking about the user 
experience in advance, you can figure 
out how to present the information and 
give users ways to interact with it while 
understanding what’s important.

Other considerations should include the 
following: 

1. Am I vocally or digitally providing text 
alternatives for images and infographics? 

2. Do my theme colors meet minimum 
contrast requirements? 

3. For digital delivery of an actual PPT file, am 
I providing keyboard-based information 
the user can access that offers important 
information and context? 

4. Am I using color alone as a way to 
understand content or interactions? (Item in 
Red are behind schedule.)

Considering 
accessibility in the 
concept stage of 
creating a PowerPoint 
allows for the most 
freedom to change and 
has the least impact 
on schedule and 
development. 
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Starting at the Draft Stage 
If someone has already started designing your PowerPoint template or presentation all is not 
lost. You still have time to make accessible design and content choices. Color palettes can 
be reviewed. Text alternatives and presentation methods for things like tables and complex 
infographics can be evaluated for barriers and meaningful information. 

However, changes may be harder to implement at this stage. Those who approve the 
content may have already formed attachments to the draft colors and methods. The best 
way to shift sentiment at this stage is to provide solutions when encountering barriers. If the 
table is not accessible, create one and present the solution when discussing the challenge. 

In my career, I have experienced overwhelmingly negative pushback when my 
evaluations only surfaced accessibility failures without also providing solutions. 

Starting at the Final Stage 
Even if you are starting at the end, there is still hope for creating an accessible presentation. 
With many visualizations, you can slightly darken colors to meet contrast thresholds and 
adjust alternate descriptions to be more meaningful. For a PDF delivery of your presentation 
you can modify accessibility  tags to present a better user experience for those using 
assistive technology. Taking these steps is not always easy. Starting accessible modifications 
after the project is fully developed can be like baking an apple spice cake for someone who 
doesn’t like apples and asking, “can’t you just take them out?” 
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Two Options when you must 
have animations
If your presentation must have 
animations consider creating a separate 
accessible presentation that uses 
sequential slides rather than animated 
objects. 

Or consider a static slide with text on 
the slide that explained the meaninful 
context of the animation to the reader. 
Avoid putting this description in the 
speakers notes area as this area is hard 
for come AT users to access.

All About Animations

Accessible Presentations Avoid Animations
Animations in PowerPoint presentations can present significant accessibility challenges 
for people using assistive technology. One key challenge is bridging the gap between 
the animation and the context of what is happening on screen. Animations that convey 
more than “appear” and “disappear” actions can make it difficult for screen reader users 
to understand what is happening on screen. This is because screen readers are software 
programs that read out the content on a screen, allowing visually impaired individuals to 
access digital content. When animations are used excessively or in a way that doesn’t follow 
accessibility guidelines, screen readers may struggle to interpret and describe the content 
accurately. For example, if text or important elements are hidden behind animated objects 
or appear only briefly, it can be nearly impossible for someone relying on a screen reader to 
understand the full context and meaning of the presentation.

Avoid auto-play or animations with sound effects
Another challenge with animations in PowerPoint is the potential for sensory overload. 
Some animations, such as rapid transitions, flashing our sound effects with complex motion 
paths, can be visually distracting and overwhelming for individuals with cognitive or sensory 
disabilities. These animations may cause difficulties in maintaining focus, understanding the 
sequence of information, or even triggering physical discomfort for people with conditions 
like epilepsy. Sound effects can also mask the screen reader voice making it difficult to hear 
instruction from their accessibility tool. Animations can significantly impede the ability 
of individuals using assistive technology to comprehend and engage with the content 
of a PowerPoint presentation, ultimately excluding them from fully participating in the 
information-sharing process. To ensure inclusivity, it is essential to use animations sparingly 
and provide alternative ways to convey the same information in a more accessible manner.
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Step 1: Document 
Information
When you fill out the file information 
like the title, author, description, 
and keywords, it not only helps with 
search engine optimization (SEO), but 
it also makes your PowerPoint more 
organized, searchable, and accessible. 
These properties give important details 
about the file without needing to open 
it. The title gives a quick summary of 
what the file is about, and the author 
shows who made it. However, if you’re 
posting the PowerPoint online, it’s a 
good idea to use your company name 
as the author, so people can search for 
it easily. A well-written description adds 
more information and helps users know 
if the file is relevant to them. Keywords 
are like special words that make it easier 
for people to find your file. By taking 
the time to fill out these file properties, 
you make it simpler for others to find 
and understand your PowerPoint, which 
helps with finding information quickly 
and keeping your files organized.
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Document Language 
Powerpoint uses the default language of 
your install for new templates. However, 
if you are creating PowerPoints in other 
languages remember that you should 
set the language to the main natura 
language of the document. Screen 
reader users who have French language 
packs installled will be able to hear it in 
that language. However this does not 
enable all users to listen in French. So 
if you are testing your document and 
wonder why it sounds like “FrEnglish” it 
is likely that your computer is not setup 
to vocalize French. When making a PDF 
of a PowerPoint remember that there are 
special operations you will need to take 
to assign language to specific parts of 
your document if it contains French and 
English or a combination of languages.

Review > Language >  Language Preferences > Set Proofing Language 

1
2

3

4
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Step 2: Choosing or 
Creating a Template

Unique Slide Titles
Having unique slide titles in your 
accessible PowerPoint is important 
for a few reasons. First and foremost, 
unique slide titles enhance the overall 
organization and structure of your 
presentation. Each slide title acts as a 
roadmap, providing a concise preview 
of the content on that particular slide. 
This enables individuals who are using 
screen readers or assistive technology 
to navigate through the slides more 
efficiently. With unique titles, users can 
quickly identify and jump to specific 
slides of interest, saving time and 
enhancing their understanding of the 
presentation’s flow. When you have 
more than one “Continued…” slides it 
can be helpful to label them 1 of 3 to 
give additional information to the screen 
reader user.

Unique slide titles also contribute to 
the accessibility and comprehension of 
your PowerPoint for a broader audience. 

For individuals with visual impairments, screen readers rely on slide titles to provide context and 
convey the main points or topics covered on each slide. By using descriptive and distinct titles, 
you help ensure that the content of your slides is accurately conveyed, allowing all attendees, 
including those with disabilities, to follow along and grasp the key messages being presented.

The best way to check for unique titles is by using the Outline Mode. 

View > Outline View

1

2
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Title Slide holds your H1

While we cannot directly control heading 
levels in our PowerPoints at a textbox level, 
the Title template slide is the only slide 
with a built in Heading Level 1 (H1). As I 
already noted, your heading structure is the 
roadmap of your document. All documents 
should start with an Heading Level 1.

All other slides are H2
If the Title slide is our H1 (Heading Level 
1), our secondary slides are all Heading 
Level 2s. You cannot set beyond H2 in a 
PowerPoint currently. Indented Lists are 
not considered heading levels. Again, 
setting up and using a template maximizes 
accessibility of our presentation.

Every slide is a Sect/Story
If you have ever opened the accessibility 
tags in a PowerPoint you may have noticed 
all the <Sect> tags. These tags are the 
default for each slide. They are not read by 
assistive technology but can be helpful to 
keep your content organized in the tags 
tree. Some people prefer to remove them 
all with third-party tools like axesPDF or 
CommonLook but it is completely up to you. 

Slide template dictates heading levels Each Slide becomes a <Sect> in the PDF

H1

H2

H2

H2

H2

H2
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Consistent placement
Anticipation and the Cognitive Barrier
Using a consistent layout for elements 
in your PowerPoint presentation can 
greatly reduce cognitive barriers and 
readability. When elements such 
as headings, text, and images are 
consistently placed on slides, it creates 
a sense of familiarity and predictability 
for the audience. Familiar placement 
allows the audience to focus more on 
the content itself rather than figuring 
out where to look for information. 
For example, by placing headings 
consistently at the top or on the left side 
of the slide, readers can anticipate where 
to find important information related 
to that heading. This helps in quickly 
scanning the slide and understanding 
the organization of the content, which 
improves comprehension and overall 
cognitive processing.

When fonts, font sizes, and colors are 
used consistently throughout the 
slides, it enhances visual harmony and 
reduces visual distractions. Additionally, 
maintaining consistent alignment, 
spacing, and positioning of elements like 
text and images creates a more visually 

pleasing and accessible presentation. By avoiding sudden changes in formatting or layout, you 
create a smoother reading experience for the audience, allowing them to focus on the message 
rather than being overwhelmed by inconsistent visual elements. It is all subliminal, but haven’t 
you ever left a presentation that you just found easy to understand but weren’t sure why? Often 
this is because the visual processing load was low and allowed you to be emersed in the content.

(1) Title, (2) Content, (3) Image all have consistent placement and formatting

1

2 3
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Leverage Slide Templates
Now that you know why you should use Slide templates. Lets talk about what you put 
on them. Remember that you are striving for a consistent location and style of your intial 
content. 

The Master Slide
This slide contains items that will appear on every slide. You can choose which elements you 
want for all slides by right clicking on the Master slide and choosing “Master Layout…” From 
here you can select from title, text, date, slide number and footer. Elements selected here 
will appear on every slide. However, you can add elements to your child slides to hide Master 
slide elements.

1. Slide Title: Your Title should be visually distinguishable from your body copy. My 
personal preference is that it should be 10 to 12pts larger than your body copy. If your 
body copy is 32pt your Heading should be 42 to 48pt. I know that sounds large but 
again, it will largely depend on your overall content.

2. Color: When choosing a color for your Title you will need to maintain a 3 to 1 color 
contrast. (see Color Contrast for more info)

3. Logo Placement: Consider size and placement that does not distract or clutter the 
slide.

4. Master Footer: Your footer can contain the date, custom text and the page number. 
This can be set by right clicking on the Master slide and choosing Master Layout. If you 
have already created your slides and want to add the footer afterwards you can select 
Insert > Header & Footer. The dialog box that pops up will allow you to add elements 
to the current slide or all slides.

Note: Once you have started laying out your slide deck, deselecting items from this list 
will not remove footers from existing slides.  Use Insert > Header/Footer to remove them 
from a slide or the entire deck. 

Elements to choose from:

Header/Footer Options

13 of 31

Ultimate Guide to Accessible PowerPoints
Dax Castro, ADS

Accessing Higher Ground 2023



Other Accessibility 
Considerations

1. Accessibility Consideration 1: Visual 
Page numbers are not required when 
your final output is a PDF. Acrobat has 
their own page numbering system. 
However, if you choose to add page 
numbers, make sure they match the PDF 
page numbers.

2. Accessibility Consideration 2: If the 
information in the footer contains vital 
information and needs to be presented 
to the user you will need to copy the 
footer information in text boxes or 
manually tag the content in the PDF. 
If you use the default boxes in the 
template they will be ignored by screen 
reading assistive technology. Typically 
you would only do this on your first or 
last slide of the presentation.

Bug Alert: If you include the page number in your template and you add content later it is 
possible that your content may not get tagged correctly if you did not set your reading order. 
PowerPoint currently hides the item directly above the page number in the Reading Order 
pane. Therefore you need to make sure you adjust your reading order so that the page number 
is read last. Or if you are using the Selection Pane to set your reading order, that the page 
number is the top most item in the selection pane.

PowerPoint will artifact any element directly above the page number placeholder
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Step 3:  
Selecting Fonts and Sizes

Accessible fonts
While most people agree that San Serif fonts 
are easier to read, there is no real definitive 
study to support the claim. What makes 
the most impact is spacing, line height and 
consistency.

Source Sans, Tahoma, Calibri, Helvetica, 
Arial, Verdana, and Times New Roman are 
all considered as accessible fonts. However 
be aware that letters like Capital I and 
lowercase l, or b and d can be confusing 
in many san-serif fonts. My goto is font is 
often Source Sans. Notice the tails on the 
lowercase letter l.

Illustrator: Calibri Bold

Illustrator: Source Sans Bold

Dax’s Recommendations for  
font sizes:

1. Headings: 36 to 48 pt
2. Body/Bullets minimum: 24 to 32pts
3. Footnotes/References: 18pt

Step 4:  
Picking your Color Pallette

Color Contrast
Color Contrast is the the difference in 
luminance or color between a graphic 
or text element and its neighbor or the 
background. It plays a crucial role in making 
content readable to all individuals, including 
those with low vision.While WCAG only 
requires a 3 to 1 Color Contrast I strive to 
meet 4.5 to 1 just to make sure that all my 
text can be read regardless of room lighting 
or method of presentation.

Regular text: Any text smaller than 18pt or 
14pt bold. Regular text must have a 4.5 to 1 
color contrast ratio to it’s background.

Large Text: Any text that is 14pt bold or 
18pt and larger. Large text requires a 3 to 1 
color contrast because the text is larger and 
generally easier to see.

While there are online tools that allow you 
to paste color values into them to figure 
out the color contrast, the easiest way to 
evaluate contrast is with a free tool called 
the Color Contrast Analyzer by TPGI. https://
www.tpgi.com/color-contrast-checker

TPGI Color Contrast Checker Interface
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Using color alone to 
distinguish elements
WCAG Success Criteria 1.4.1 Color 
Only (Level A). Color is not used as 
the only visual means of conveying 
information, indicating an action, 
prompting a response, or distinguishing 
a visual element. 

This accessibility guideline ensures that 
important information or instructions 
are not conveyed only through color. 
Some people may have difficulty seeing 
or interpreting colors, so it’s important to 
provide alternative ways to understand 
the content.

Imagine you come across a website that 
uses only color to indicate whether a 
button is selected or not. If you cannot 
see the colors properly, you may get 
confused or miss important information. 
This success criterion ensures that 
websites use other visual cues, like 
symbols or text, in addition to colors.

For example, if a slide contains different colored cells in a table that indicates project status, they 
should also have labels or symbols to indicate their values as well so people can understand them 
even if they can’t see the colors clearly.

Colorblind simulated view for someone with Deuteranopia (most common form of colorblindness)
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Step 5: Adding Content 
Accessibly

Controling Reading Order
One of the most overlooked accessibility 
barriers is checking and setting the 
Reading Order. It is not an issue when 
you stick to the template and have 
simple Title and bullet content. But the 
moment you start copying and pasting 
content from other sources or adding 
elements to the slide you run the risk 
of mixing up the reading order of the 
elements on the page. This is easily 
fixable but you have to know where to 
look. The answer to “Okay, where do I 
look?” is “It depends.” If you are using a 
current Windows version of Office 365 
you can use the Read Order Panel. But, 
if you are using a MAC or are using the 
Browser-based version of Office 365 you 
must use the Selection Pane.

Controlling content with the Reading Order Panel
This is a new option that has been recently added for most of the world running Windows 
desktop versions of Office 365. It is so much better than the Selection Pane method and really 
makes setting the Reading Order very easy. 

You can access the Reading Order Pane from the Review > Accessibility > Reading Order

From this panel you will be able to set the reading order in a natural top-down method. You will 
see all the elements are conveniently numbered. If you double click on any item you can directly 
access the image descriptions. If an element does not have an image description you will see a 
warning triangle next to the item. If you would like to omit (artifact) a decorative item like the 
numbered circles in the example you just simply uncheck the boxes. Unlike the Selection Pane, 
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this does not remove the item from the visual page. It only hides it from people using 
assistive technology. Read more on that topic in the section of this handout titled Alternate 
Descripitons.

Controlling content with the Selection Pane
This panel is less robust and does not include direct access to alt-text descriptions or have 
the ability to mark something as decorative. You simply drag the items up or down to adjust 
the order from the bottom up. The bottom-most item is the first item read by assistive 
technology. The top-most item is the last. If you are including slide numbers you will want to 
make sure they are at the top (last) to avoid the bug we discussed earlier.

You can access the Selection Pane via the Home tab > Arrange > Selection Pane.

Depending on your slide content you 
may see more or less items from this 
view but the typical items you will see 
here are labeled:

• Title 1
• Text Placeholder 2
• Picture 1
• Date Placeholder 1
• Footer Placeholder 2
• Slide Number Placeholder 4

Note If you are trying to meet HHS 
Accessibility standards each of these 
elements must be properly labled. 

1 2

3
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Step 6: Alternate Descriptions for Images
All non-text content requires one of two things. Either you mark it as decorative or you provide a 
short but meaningful description. How do I know if I should mark something as decorative? Ask 
yourself: “If this item were not here would the reader lose any valuable information?”

Example Line graph

Now put it all together:
Annual Sales in millions of dollars for Headphones, earbuds and speakers by quarter showing 
a significant drop in wireless ear buds hitting a $1.8M low in the 3rd Quarter. Wireless 
headphones and bluetooth speakers showed a steady increases from the second quarter to 
the end of the year with sales for ear buds at $4.5M and $5M for bluetooth speakers.

What should I say?
1. Set the Stage 

Annual Sales for Headphones, 
earbuds and speakers…

2. Describe the Axis/Legend 
sales in millions of dollars by 
quarter…

3. Relate quantity/trend 
showing a significant drop in 
wireless ear buds hitting a $1.8M 
low. Wireless headphones and 
bluetooth speakers showed a 
steady increases from the second 
quarter to the end of the year…

4. If it has data/values your 
description should have some 
too! 
"...with sales for ear buds at $4.5M 
and $5M for bluetooth speakers."

19 of 31

Ultimate Guide to Accessible PowerPoints
Dax Castro, ADS

Accessing Higher Ground 2023



Describing an Image
What should I say?

1. What are the important features of 
the setting, if any? 
A canal with high vertical metal 
walls. 

2. Are there actions or interactions? 
fast moving water

3. Does describing the subjects add 
value to the description? 
A ladder and saftey chain are 
shown 

4. Avoid adding non-descriptive data 
unless it would be obvious to the 
visual reader. 
as escape methods should 
someone fall in.

Now put it all together:
A canal with high vertical metal walls 
and fast moving water. A ladder and 
saftey chain are shown as escape 
methods should someone fall in.
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Where to add Alt-text
Right click on any image and choose 
View Alt-text. Here you can enter your 
description.

Well-written Alt-text 
• 2-3 sentences 
• Describes the main point or 

elements of an image
• Starts with the most important info 
• Includes quantitative data if it 

exists in the image, chart or graph.
• Avoid visual layout like extra hard 

returns (not read by screen readers)
• Avoids excessive use of symbols
• Avoids hyperlinks since they are 

not interactive in alt-text

NOTE: Did you know someone 
using assistive technology cannot 
pause alt-text and must start from 
the begining if something is missed.

1

2
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Step 7: Create Accessible Links
Repeating Links in the footer of your slides should not be active. PowerPoint will hide them from 
the screen reader (artifact them) by default. However if you assign a url to them, you may get errors 
when running the PDF Accessibility Checker if you are creating a PDF from your PPT. 

1. Highlight the text or select your image.
2. Right Click and choose Insert Link.
3. Enter the URL and then in the top right corner click the Screen Tip button and add a short description 

for the user to know where they are going if they click the link.
4. Click Ok.

Don’t forget the Screen Tip
When seting a link in the content 
of your slide you should always add 
a Screen Tip. This is the descriptive 
text the screen reader user will hear 
when they encounter the link. “Apple 
Store link to Sim Daltonism” is much 
more descriptive than “https://apps.
apple.com/us/app/sim-daltonism/
id693112260?mt=12”

Click Here
Avoid phrases like “Click here,” “Watch,” 
or “Read More” without context. “Click 
here to download the Accessibility 
Report,” “Watch the video on Vimeo” 
or “Read More about alpaca” are much 
more informative links. 
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Step 8: Use Accessible Colors in Graphics
As we have discussed before color plays an important role in the accessibility of graphics. 
The use of labels instead of legends also improves cognitive understanding. When we 
consider color there are two accessibility barriers we are trying to mitigate – Low vision and 
color blindness. We have already discussed color blind considerations and WCAG 1.4.1 Use of 
Color. Let’s discuss the other potential barrier; low vision.

Low Vision Considerations
WCAG Success Criteria 1.4.11 Non-text 
Contrast (Level AA)

The visual presentation of the parts 
of graphics required to understand 
the content have a contrast ratio of 
at least 3:1 against adjacent color(s). 
https://www.w3.org/WAI/WCAG21/
Understanding/non-text-contrast.html

Color contrast is the determining factor 
for low vision. Ask yourself:

• “Can someone with low vision tell 
one thing from another?” 

• “Are text labels or data points dark (or 
light) enough to be read against the 
page or background colors of charts, 
graphs and infographics?”

• “Are the important elements in my 
map or infographic dark enough 
to meet the 3 to 1 color contrast 
requirement?”
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Step 9:  
Create Accessible Tables
What makes a table accessible? Here are 
my 10 basic accessible table qualifiers:

1. It is not an image
2. It has logical structure with the 

same number of columns in every 
row.

3. It has no blank Column headers.
4. It avoids cramming unlike items 

together for aesthetic reasons.
5. It doesn’t use blank columns to 

visually style or separate data.
6. It does not use colored cells as 

the only way to communicate 
information.

7. It does not use symbols alone to 
communicate information

8. It avoids merged cells (when in PPT 
format. PDF is okay but requires 
extra steps).

9. The title of the table is not 
embedded in the first row.

10. Footnotes are not embedded in 
the last row

BONUS: The A1 cell can be blank but 
you will need to modify it in your PDF 
and mark it as a TD.

The A1 Cell Column Header
Stacked Stacked

Split Cell Split Cell

Row Header Table Data Table Data Table Data

Row Header Table Data Table Data Table Data

Merged Cell

Table Data Table Data Table Data

Table Data Table Data Table Data

Footer Row Footer Row Footer Row Footer Row

Layout tables 
While most accessibility professionals 
avoid tables that are used only for 
the purpose of spacing out or visually 
dividing graphics or paragraphs 
of text, it is not a barrier if the 
presentation of the elements when 
read left-to-right, top-to-bottom make 
logical sense. However, be aware that 
you will not pass any accessibility 
checkers unless your table has column 
headers. So it is best to avoid them 
whenever possible.
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Step 10: Create Accessible Video in PowerPoint

A note about Captions and Subtitles.
Captions are text that in the same language as the live presenter or the video content. 
Subtitles are when the spoken word is translated to a different language. PowerPoint, 
however, does not diffentiate the two. To set live captions you go to the Slideshow tab (1) 
and then select “Always Use Subtitles (2). Then you can choose the base language or have 
them translated to a different language (3) . Live captioners are always a better choice than 
automation, but if you need to set them for your presentation the alternatives are there.

You can adjust the position of the captions or subtitles (4) as well as which microphone to 
listen to. Remember to turn this off if you are in a Zoom meeting or other online meeting 
where their platform also provides captions. Otherwise you will get one on top of the other.

When live PPT files are shared ensure 
your video content is not set to 
autoplay

It is important that your video content is 
not set to autoplay when delivering a live 
PPT source file to someone who may use 
a screen reader. When the video plays it 
can be startling and if there is speech or 
music it can overshadow the users screen 
reading assistive technology. Always 
make sure your video content is set to 
play on click. Another key accessibility 
function is not hiding the controls or 
moving them off screen. A user should be 
able to easily control start, stop, pause, 
volume or mute. 

1 2
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Use Video Captions
Captions should always be available 
for your video content. Captions come 
in two variations. Open Captions and 
Closed Captions. Open Captions are 
burned into the video and are part of 
the actual video file. Closed captions are 
produced via a separate file and can be 
available in several language options for 
the user. 

A great tool I always recommend is the 
free plugin STAMP if you need to include 
video in your actual presentation rather 
than hopping out to YouTube or Vimeo. 
STAMP has several ways to import 
captions or create your own. The option 
for creating your own can be a bit clunky 
at first but with some practice you can 
get the hang of it. However, if time is 
valuable, creating Open Captions that 
are burned into the video really saves a 
ton of time.

Options for creating captions:
1. Adobe Premiere has a new captioning feature that lets you produce open or closed 

captions. It also lets you produce a transcript as well.
2. YouTube studio allows you to add captions manually as PowerPoint compatible VTT files.
3. STAMP Subtitling Add-In for Microsoft PowerPoint https://blogs.microsoft.com/

accessibility/subtitling-add-in-for-microsoft-powerpoint-stamp-now-supports-office-
2013-and-later/
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Does your Video-only content have audio descriptions or a transcript?
Much like audio-only content, video only content can be a signifcant barrier for people who 
are blind or low-vision. The best option is audio descriptions. To hear a great example of a 
video with audio descriptions visit this Vimeo video from the Blind Institute of Technology. 
https://vimeo.com/820638084/f9d28374f4 

A secondary alternative is a digital transcript in the form of an accessible PDF or Word 
document that a person could access using assistive technology. Giving this file out ahead of 
time is proper ettique to allow the audience time to review the content.

Do you have  
Audio-only content?
Are you playing a clip from a podcast or 
radio program? To consider those you 
are Deaf you will want to have captions 
on screen as well. Otherwise you can 
provide a transcript ahead of time as a 
less-inclusive but accessible option. 
Transcripts include things like speakers 
names, sounds, and can include time 
stamps if you feel the need to add them.

Transcript sample from Otter.ai
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Step 11: Run the 
Microsoft Accessibility 
Checker
When you are finished with your 
document and have incorporated all the 
steps above you should have very little 
errors in your document. However, if you 
are running the checker on a document 
you did not create you will need to 
understand what the errors mean and 
how to fix them. The good thing is that 
Microsoft does a pretty good job of 
walking you through it.

NOTE: The current Microsoft Checker 
in PowerPoint does not check for 
minimum color contrast.

Typical Accessibility Checker Warnings and Errors
1. Missing Slide Title: Make sure every slide has a title. Sometimes you might need to hide one 

behind an image if your entire slide is just an image.
2. Duplicate Slide Title: Use Continued (1) or Continued (2) but each slide title must be unique.
3. Missing Object Description: Right click on the image and add a short meaningful 

description
4. Use of Merged or Split Cells: This only matters when you are delivering a live PPT file to 

someone who will need to use assistive technology to read it. If you are exporting to PDF 
you should ensure you table has proper Scope and Spans set for accessibility.

5. Check Reading Order: Use the Reading Order or Selection Pane to verify the order.
6. Mission Audio or Video Subtitles: Add them or provide accessible alternatives.
7. Review Auto-Generated Descriptions: Please don’t use these. Just don’t They are never 

good and no one likes “Possible image of sunglasses. Generated with medium confidence” 
as an image description for a chart or graph. (yes, this really is true example)
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The following table provided by Microsoft includes key best practices for creating PowerPoint presentations that are accessible to people 
with disabilities.

What to fix How to find it Why fix it How to fix it

Include alternative text with all 
visuals.

To find missing alternative 
text, use the Accessibility 
Checker.

Alternative text helps people who can’t see the screen 
to understand what’s important in images and other 
visuals.

Add alt text to visuals

Make sure slide contents can be 
read in the order that you intend.

Use the Accessibility 
Checker to find slides that 
have possible problems with 
reading order.

Try navigating your slides with 
a screen reader.

A screen reader reads the elements of a slide in the 
order they were added to the slide, which might be 
very different from the order in which things appear.

Set the reading order of 
slide contents

Use built-in slide 
designs for inclusive 
reading order, colors, 
and more

Add meaningful and accurate 
hyperlink text and ScreenTips.

To determine whether 
hyperlink text makes sense 
as standalone information, 
visually scan the slides in your 
presentation.

People who use screen readers sometimes scan a list 
of links.

Tip: You can also add ScreenTips that appear when 
your cursor hovers over text or images that include a 
hyperlink.

Create accessible 
hyperlink text and add 
ScreenTips

Ensure that color is not the only 
means of conveying information.

Select Start > Settings 
> Accessibility > Color 
filters. Turn on the Color 
filter switch, and then 
select Grayscale. Visually scan 
each slide in your presentation 
for instances of color-coding.

People who are blind, have low vision, or are 
colorblind might miss out on the meaning conveyed 
by particular colors.

Use an accessible 
presentation template

Use built-in slide 
designs for inclusive 
reading order, colors, 
and more

Use sufficient contrast for text 
and background colors.

To find insufficient color 
contrast, use the Accessibility 
Checker.

You can also look for text in 
your presentation that’s hard 
to read or to distinguish from 
the background.

Strong contrast between text and background makes 
it easier for people with low vision or colorblindness 
to see and use the content.

Use accessible font 
color

Use built-in slide 
designs for inclusive 
reading order, colors, 
and more
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What to fix How to find it Why fix it How to fix it

Give every slide a unique title.
To find slides that do not have 
titles, use the Accessibility 
Checker.

People who are blind, have low vision, or have a 
reading disability rely on slide titles to navigate. For 
example, by skimming or using a screen reader, they 
can quickly scan through a list of slide titles and go 
right to the slide they want.

Give every slide a title

Hide a slide title

If you must use tables, create a 
simple table structure for data 
only, and specify column header 
information.

To ensure that tables don’t 
contain split cells, merged 
cells, or nested tables, use 
the Accessibility Checker.

Screen readers keep track of their location in a table 
by counting table cells. 

Screen readers also use header information to identify 
rows and columns.

Avoid using tables

Use table headers

Use a larger font size (18pt or 
larger), sans serif fonts, and 
sufficient white space.

To find potential issues related 
to fonts or white space, review 
your slides for areas that look 
crowded or illegible.

People who have dyslexia describe seeing text merge 
or distort.

Use an accessible 
presentation template

Use accessible font 
format and color

Make videos accessible to people 
who have a vision or hearing 
disability.

Subtitles typically contain a transcription (or 
translation) of the dialogue.

Closed captions typically also describe audio cues such 
as music or sound effects that occur off-screen.

Video description means audio-narrated descriptions 
of a video’s key visual elements. These descriptions are 
inserted into natural pauses in the program’s dialogue. 
Video description makes videos more accessible to 
people who are blind or have low vision.

Use captions, subtitles, 
and alternative audio 
tracks in videos

Create accessible PDFs or other 
file formats of your presentation.

Include accessibility tags to PDF files you create from 
your presentation. The tags make it possible for screen 
readers and other assistive technologies to read and 
navigate a document.

You can also save the presentation in a format that can 
be ported to a Braille reader.

Save your presentation 
in a different format
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Turn off the Automatic Alt-text setting. 
You can find this under Review > Check Accessibility > Options: Accessibility.

Accessibility Special 
Considerations

1. Avoid adding images or charts in the notes 
area. This area is difficult to access for those 
using assistive technology and non-text 
objects in this area can be very hard or 
impossible to read.

2. Page numbers can be included in your 
slide decks. However, ensure your on-page 
numbers match the PDF document page 
number if you are generating a PDF of your 
slides.

3. If you are trying to meet the Department 
of Health and Human Services standard for 
PowerPoint presentations you will need to 
include titles and subtitles for all objects in 
your selection pane. (See previous section: 
Ordering Objects)

4. Avoid forms or quizzes in your PowerPoint 
slides. These are not accessible and can 
provide a confusing user experience for 
people using assistive technology. If you must 
include these elements consider providing 
accessible alternative HTML or digital 
documents.

5. Turn off the Automatic Alt-text setting. 
You can find this under Review > Check 
Accessibility > Options: Accessibility.

1
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